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What is OpenType?
OpenType is a new cross-platform font file format 
developed by Adobe and Microsoft. OpenType is an 
extension of the TrueType sfnt format that can now 
support PostScript® font data and new typographic fea-
tures. OpenType fonts containing PostScript outlines 
have an .otf file name suffix, while those with TrueType 
outlines may have a .otf, .ttf or .ttc file name suffix. This 
user guide deals primarily with the installation and use 
of PostScript flavored OpenType fonts.

OpenType fonts may include an expanded character 
set and layout features to provide richer linguistic sup-
port and advanced typographic control. OpenType 
fonts from Adobe with support for central European 
(CE) languages can be distinguished by the word “Pro,” 
which is part of the font name and appears in applica-
tion font menus. OpenType fonts that do not contain 
central European language support are labeled “Stan-
dard,” and are designated by an “Std” suffix in the fonts’ 
menu names.

All OpenType fonts can also be installed and used 
alongside PostScript Type 1 and TrueType fonts.

One Cross-Platform Font File

All OpenType fonts use a single font file for all of their 
outline, metric, and bitmap data (if any), making file 
management simpler. The file names for OpenType 
fonts from Adobe are clearly descriptive. In addition, 
the same font file works on Macintosh and Windows 
computers, improving cross-platform portability for 
documents.

Better Language Support

Based on Unicode, an international multi-byte char-
acter encoding that covers virtually all of the world’s 
languages, OpenType fonts can make multilingual 
typography easier by including multiple language char-
acter sets in one font. All OpenType fonts from Adobe 
include the standard range of Latin characters used 
throughout the western world, and several international 

characters, including the euro currency symbol (€), 
“estimated” (℮), and litre (ℓ). Adobe’s “Pro” fonts add a 
full range of accented characters to support central and 
eastern European languages, such as Turkish and Polish. 
Many of the Pro fonts also contain Cyrillic and Greek 
character extensions in the same font.

Advanced Typography with OpenType Pro fonts

OpenType fonts may also contain more than 65,000 
glyphs, unleashing exciting typographic capabilities.  
Many non-standard glyphs, such as oldstyle figures, true 
small capitals, fractions, swashes, superiors, inferiors, 
ornaments, titling letters, contextual and stylistic alter-
nates, beginning and ending letterforms and a full range 
of ligatures may also be included in a single font. In the 
past, a typical Western PostScript font was limited to 
256 glyphs, forcing users to install and manage two or 
more style-related fonts in order to access “expert” or 
other supplemental characters. OpenType significantly 
simplifies font management and the publishing work-
flow by ensuring that all of the required glyphs for a 
document are contained in one cross-platform font file 
throughout the workflow.

Historically, some of the highest-quality typefaces have 
had different designs for different print sizes. Called 

“opticals,” these variations have been optimized for use at 
specific point sizes. A number of OpenType fonts from 
Adobe include four optical size variations. Although 
the exact intended sizes vary by family, the typical size 
ranges include: caption (6–8 point), regular (9–3 point), 
subhead (4-24 point) and display (25–72 point). If pres-
ent, a size intended for even larger use (>72 point) is 
called “poster.”

Unbelievable  Caption

Unbelievable  Regular (Text)

Unbelievable  Subhead

Unbelievable  Display  

Macintosh Windows
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Overall, OpenType provides richer support for the 
world’s languages, more powerful typographic capa-
bilities, better cross-platform compatibility, as well as 
simplified font management. For more information on 
OpenType, please refer to the Adobe web site at  
http://www.adobe.com/type/opentype.

Minimum System Requirements  
for PostScript flavored OpenType Fonts

Macintosh
 • Macintosh with PowerPC® processor
 • Mac OS 8.6 to 9.2 or Mac OS X
 • ATM® Light or Deluxe, version 4.6 or later  

(not required for Mac OS X native)
 • AdobePS printer driver 8.6 or later recommended  

if using a PostScript printer with Mac OS 8.6 to 9.2
 • ATM updater to 4.6.1a/4.6.2a,  

if using AdobePS 8.8 or later
 • 16 MB of RAM

Windows
 • PC using a Pentium® or compatible processor
 • Microsoft Windows® 95, 98, Millennium Edition (ME), 

Windows NT® 4 (SP 4), Windows 2000 or Windows XP
 • ATM Light or Deluxe 4.1 or later  

(not required for Windows 2000/Windows XP)
 • AdobePS printer driver 4.3 or later, if using  

Windows 95/98/ME with a PostScript printer
 • AdobePS printer driver 5.1.2 or later, if using  

Windows NT 4 with a PostScript printer
 • 16 MB of RAM

Note: Mac OS X, Windows 2000 and Windows XP 
(Home and Professional) provide native support for 
PostScript flavored OpenType fonts (as well as PostScript 
Type 1 fonts) and do not require ATM Light or the Ado-
bePS printer driver.

Additional Software Installation
Before using your PostScript flavored OpenType fonts, 
users of older operating systems may need to install the 
latest versions of the Adobe Type Manager Light soft-
ware and the AdobePS printer driver, which are both 
available as free downloads from the adobe.com website.

Adobe Type Manager (ATM) Light

Adobe® Type Manager® (ATM®) Light is a 
system software component that automati-

cally generates high-quality screen font bitmaps from 
PostScript® Type 1 or PostScript flavored OpenType 
outline font data. With ATM, you can use Type 1 and 
OpenType fonts at any size, and you can also enable 

“font smoothing,” (anti-aliasing) which further improves 
the appearance of your fonts on-screen. ATM Light also 
allows you to print your PostScript Type  or PostScript 

flavored OpenType fonts to both PostScript and non 
PostScript printers.

Note: Windows 2000 and Windows XP do not require 
ATM Light. Mac OS X only needs ATM Light to pro-
vide support for “Classic” applications, not for Carbon or 
native applications. 

To download ATM Light, go to:  
http://www.adobe.com/products/atmlight/main.html. 
If using AdobePS 8.8 or later, you should also update 
ATM to 4.6.1a/4.6.2a. The update is available at: http:
//www.adobe.com/support/downloads

Note: Adobe recommends that once you install ATM 
Light, you increase the utility’s character cache setting (the 
amount of memory allocated for storing font information 
and drawing it to your computer screen) to at least 512K 
in Windows 98/ME (newer versions of Windows do not 
have a character cache setting), and to at least 1MB in 
the Macintosh version. To increase this setting in the Win-
dows version, select the “Settings” tab in the ATM window. 
On the Macintosh, it is in the main control panel for ATM 
Light; in ATM Deluxe, select the “Preferences…” com-
mand in the File menu.

AdobePS Printer Driver

If you are printing to a PostScript printer or 
creating PostScript print files (perhaps for 

Adobe Acrobat Distiller), the AdobePS printer driver 
replaces your standard Mac or Windows printer driver 
and offers several improvements. Installation of this 
driver requires a PostScript Printer Description (PPD) 
file for your printer, which allows the driver to con-
trol all of your printer’s features, such as optional paper 
trays, enhanced imaging modes, and duplex (two-sided) 
printing. More instructions are included in the Read Me 
file that comes with the AdobePS software. 

To download the latest AdobePS printer driver 
for the Macintosh, point your browser to http://
www.adobe.com/support/downloads/pdrvmac.htm

http://www.adobe.com/type/opentype
http://www.adobe.com/products/atmlight/main.html
http://www.adobe.com/support/downloads
http://www.adobe.com/support/downloads
http://www.adobe.com/support/downloads/pdrvmac.htm
http://www.adobe.com/support/downloads/pdrvmac.htm
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To download the latest AdobePS printer driver for Win-
dows, point your browser to http://www.adobe.com/
support/downloads/pdrvwin.htm

Note: Mac OS X, Windows 2000 and Windows XP 
include a native PostScript printer driver that supports 
PostScript flavored OpenType fonts.

OpenType & Font Management  
Utilities
Because PostScript flavored OpenType fonts are a newer 
format, you need to check that the version of the font 
management application you are using supports them. 
If you are using ATM Deluxe to manage your fonts, 
version 4.1 or higher for Windows and version 4.6 or 
higher for Macintosh support the activation and man-
agement of OpenType fonts. Note that font managers on 
Mac OS X can only activate fonts for carbon and cocoa 
applications (not Classic applications).

For further instructions on how to install OpenType 
fonts with ATM Deluxe or any other font management 
application, please refer to your font management appli-
cation’s documentation.

Windows Font Managers Supporting OpenType

Adobe Type Manager (ATM) Deluxe 4. 
Font Navigator—not supported (as of version 4) 
Font Reserve 2.6.5 and higher 
Font Reserve Server .6 and higher  
Suitcase 9.2 and higher (with Windows 2000/XP only)

Mac OS Font Managers Supporting OpenType

Adobe Type Manager (ATM) Deluxe 4.6 
 (only for Mac OS 8/9/Classic) 
Font Agent Pro—all versions 
Font Reserve 3. and higher (OS X only) 
Font Reserve Server .6 and higher (OS X clients only) 
Master Juggler—not yet supported 
Suitcase 0 and higher (OS X only)

Installing PostScript flavored  
OpenType Fonts Without a Font Manager
All the information required for OpenType fonts is con-
tained in a single file with an “.otf ” suffix at the end of 
the filename. This font file is a cross-platform file, and 
can be installed on both the Macintosh and Windows 
platforms.

Note that for both Mac OS and Windows, if you only 
need to use the fonts in select Adobe applications (such 
as InDesign, Illustrator and Photoshop), you may 
place the fonts in the applications’ font folder, or in the 
Adobe common font folder. This approach bypasses the 

operating system altogether, so that the normal system 
requirements no longer apply.

Installing on Mac OS

Using your fonts on Mac OS 8.6 to 9.2 or Mac OS X 
“Classic” requires the presence of ATM Light 4.6 or later 
(4.6.2 for Mac OS X Classic). Mac OS X has built-in 
support for OpenType fonts with carbon or native appli-
cations, and only requires ATM Light for “classic” apps. 

If you are running Mac OS X, decide if you want to 
install fonts into both the Classic environment and the 
OS X native environment, or only for carbon/native 
applications. If you want your fonts to be accessible to 
both Classic and carbon/native applications, install into 
the Classic environment. If the fonts only need to be 
accessible to carbon/native applications, install into the 
Mac OS X “native” environment.

Mac OS 8.6 to 9.2, or Mac OS X “Classic”

1 Before installing your OpenType fonts, quit all active 
applications.

2 Locate the folder that contains the OpenType fonts 
you want to install. 

 If you have purchased OpenType fonts from Adobe 
online, they will have been decompressed to a folder 
on your hard drive. If you have purchased multiple 
font packages, each will have its own folder.

3 Copy or move all the OpenType font files from 
their individual font folders into the System Folder 
> Fonts folder. They must be loose inside this folder, 
not in a sub-folder.

The fonts are now installed and will appear in the font 
menus of your applications. OpenType fonts installed in 
Mac OS X Classic will also appear in the font menus of 
native and Carbon applications

Mac OS X native

Mac OS X has built-in support for PostScript flavored 
OpenType fonts. You do not need to install ATM Light 
to use fonts in the Mac OS X native environment, only 
for the Classic environment.

http://www.adobe.com/support/downloads/pdrvwin.htm
http://www.adobe.com/support/downloads/pdrvwin.htm
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Fonts installed under the Mac OS X native environment 
will only by available to carbon and native applications 
running in OS X (not Classic applications). Depending 
on how they are installed, they can be accessed by (a) 
any user or (b) just by an individual user.

1  Before installing your OpenType fonts, quit all active 
applications.

2 Locate the folder that contains the OpenType fonts 
you want to install. 

 If you have purchased your fonts online, they will 
have been decompressed to a folder on your hard 
drive. If you have purchased multiple font packages, 
each will have its own folder.

3 Copy or move all the OpenType font files from their 
individual font folders into either of the following 
locations.

 (a) <Volume>/Library/Fonts/ 
Note: you must be logged on as an “Administrator” 
to place fonts in this location. Fonts in this location 
can be used by any user.

 (b) <Volume>/Users/<username>/Library/Fonts/ 
Note: fonts in this location can be used only by the 
specified user.

The fonts are now installed and will appear in the font 
menus of Carbonized or native applications.

Installing on Windows

Installing your fonts on Windows 95/98, ME or NT 4 
requires ATM Light 4.1 or later. Windows 2000 and XP 
have native support for OpenType fonts; you can use 
the operating system’s Fonts control panel to install or 
remove new OpenType fonts.

Windows 95/98/ME or NT 4 with ATM Light

1  Choose Start > Programs > Adobe > Adobe Type 
Manager.

2  In the ATM window, click the “Fonts” tab.

3  Choose “Browse For Fonts” from the Source pop-up 
menu.

4  Navigate to the folder that contains the fonts you 
want to install. The fonts located in a folder will 
appear below the folder’s name.

 OpenType fonts purchased online from Adobe will 
be in the location where you decompressed them.

5  Select the fonts you want to install. You can click to 
select one font, Control-click to select several fonts, 
or Shift-click to select a contiguous group of fonts.

6  Press the “Add” button to install the fonts.

7 Exit ATM.

 The fonts are now installed and will appear in the 
font menus of your applications.

Windows 2000 and Windows XP

Windows 2000 and Windows XP (Home and Profes-
sional) have built-in support for PostScript Type 1 and 
OpenType fonts (both .otf and .ttf). Unless you wish to 
use multiple master fonts, ATM Light is not required 
on these OSes (however, the font management features 
of ATM Deluxe may still be helpful). Use the Win-
dows Fonts control panel to install all PostScript Type 1, 
TrueType, and OpenType fonts.

1  Double-click on “My Computer.” Then double-click 
on the “Control Panels” icon, and then the “Fonts” 
icon.

2  In the Fonts window, select the File menu, and 
choose “Install New Font.”

3  Navigate to the folder that contains the fonts you 
want to install.

 OpenType fonts from Adobe purchased online will 
be in the location where you decompressed them.

4  Select the fonts you want to install. You can click to 
select one font, Control-click to select several fonts, 
or Shift-click to select a contiguous group of fonts.
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5  Press the “OK” button to install the fonts.

6  Close the Fonts control panel when you are finished.

 The fonts are now installed and will appear in the 
font menus of your applications.

Removing PostScript flavored  
OpenType Fonts without a font manager

Mac OS (all versions)

1  Open the folder you installed the fonts into.

2  Drag the OpenType font files that you want to 
remove out of the folder and into a non-system 
folder or into the Trash.

Windows 95/98/ME or NT 4

1  Choose Start > Programs > Adobe > Adobe Type 
Manager.

2  In the ATM window, click the Fonts tab.

3  Select the fonts you want to remove. You can click to 
select one font, Control-click to select several fonts, 
or Shift-click to select a contiguous group of fonts. 
You may also elect to copy the fonts to another loca-
tion before deleting them.

4  Press the “Delete” button to remove the fonts.

5  Exit ATM.

Windows 2000 or Windows XP

1  Double-click on “My Computer.” Then double-click 
on the “Control Panels” icon, and then the “Fonts” 
icon.

2  In the Fonts window, select the Fonts you want to 
remove, and choose “Delete” from the file menu. You 
can click to select one font, Control-click to select 
several fonts, or Shift-click to select a contiguous 

group of fonts. You may also elect to copy the fonts 
to another location before deleting them.

3  Close the Fonts control panel when you are finished.

Unicode and Access to Foreign  
Language Characters & Symbols

Unicode and non-Unicode environments

Applications and operating systems that make use of 
the Unicode standard for text processing can provide 
easy access to the wide range of accented characters and 
special symbols in OpenType fonts, greatly simplifying 
multilingual typesetting. Generally, both the applica-
tion and the operating system must support Unicode to 
access the full range of language characters and sym-
bols in a font. Operating systems that support Unicode 
include Windows NT 4, 2000, XP and Mac OS X.

When the operating system and ATM  combination, or 
the application, does not fully support Unicode (such as 
Windows 95/98/ME or Mac OS 8 and 9), applications 
will be limited in their ability to access all the characters 
of an OpenType font. 

In such cases, generally the application can only access 
and print the basic 256 characters of western lan-
guages—the Win-ANSI (codepage 252) or MacRoman 
range—even though the fonts themselves may support 
additional languages.

The exceptions are applications which provide their own 
font and Unicode support independently of the oper-
ating systems, such as Adobe InDesign (all versions), 
Photoshop (6, 7, CS) and Illustrator (CS). In these cases, 
it does not matter whether the system supports Unicode. 

OpenType fonts which are strictly “pi” or symbolic fonts 
may not have any characters in the Win-ANSI or Mac-
Roman range. With such a pi font, if an application does 
not support Unicode, then none of the characters of the 
font would be accessible in the application.

Character access from the OS & applications

All the Unicode-encoded glyphs in an OpenType font 
will show up in the Windows NT 4, Windows 2000 and 
Windows XP Character Map accessory, allowing direct 
copying and pasting of any OpenType glyphs into any 
application that supports Unicode.

On Mac OS X, the Character Palette performs a similar 
function. OS X users can also install and select a Uni-
code keyboard that allows direct access to any Unicode 
character, within most applications that support Uni-
code. Note: the Character Palette may not work consis-
tently with Adobe applications prior to the CS series.



OpenType User Guide6 OpenType User Guide 7OpenType User Guide6 OpenType User Guide 7

Some applications offer additional options for getting 
Unicode characters into the application. For example, 
all versions of InDesign support import of Unicode text 
files and Microsoft Word for Windows files containing 
Unicode characters. Additionally, as described at more 
length below, InDesign and Illustrator’s Glyph Pal-
ette allows access to any glyph in the font, even glyphs 
that are unencoded and not accessible in the Windows 
Character Map.

Switching between the character sets of the differ-
ent languages supported by OpenType fonts can be as 
simple as changing the current keyboard language set-
ting (if also supported by the application). This kind 
of  “on-the-fly” keyboard switching with OpenType is 
supported by Windows NT 4, Windows 2000, Windows 
XP and Mac OS X. Additionally, the Windows NT, Win-
dows 2000, and Windows XP “Character Map” acces-
sory is Unicode-aware, and allows you to directly access 
any encoded character in an OpenType font.

Language switching in Adobe applications

In some current-generation Adobe applications, Uni-
code and language support are handled independently 
of the operating system. InDesign, Illustrator and 
Photoshop, for example, support direct keyboard input 
of a wide range of languages beyond the usual western 
European set, including Greek, Cyrillic, and central and 
eastern European languages.

Platform-specific Mac and Windows Characters  
in applications

Applications with Unicode support in both their Mac 
and Windows versions, can access any standard char-
acter on any platform, With these applications, you 
can create a file using any character on either platform, 
and continue to view and edit the same characters on 
the other platform. Similarly, Adobe Acrobat can view 
any characters embedded in a PDF file, regardless of 
platform.

However, many widely used applications are not as 
savvy, and can only access the standard single-byte 
character set for the current operating system. In some 
cases, such as Microsoft Office, the Windows version of 
an application uses Unicode fully, but the Mac version 
does not.
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With these applications, this means that even though an 
OpenType font may have all the standard characters for 
both operating systems, the applications cannot access 
the Mac-specific characters when on Windows, or the 
Windows-specific characters when on the Macintosh. 
Therefore, you are advised against using platform-spe-
cific characters in such applications, if the document 
might need to be viewed or worked on on a different 
platform.

Note: The most common Mac-specific characters are 
the fi and fl ligatures, and some mathematical symbols, 
particularly those commonly substituted from the 

“Symbol” font. The most common Windows-specific 
characters are the ¼, ½ and ¾ fractions, and the superi-
ors ¹, ² and ³.

Application Support for  
Advanced OpenType Features

Characters and Glyphs

The distinction between characters and glyphs is central 
to a discussion of advanced OpenType layout feature 
support. Characters are the code points assigned by the 
Unicode standard, which represent the smallest seman-
tic units of language, such as letters. Glyphs are the spe-
cific forms or shapes that those characters can take in a 
font.

A key point is that one character may be represented by 
any of several different glyphs. For example, lowercase 

“a,” small cap “a” and an alternate swash lowercase “a” are 
all the same character—namely the lowercase “a”—but 
they are three separate glyphs.

Additionally, although the relationship between glyphs 
and characters is often one-to-one, it may be many-
to-one, one-to-many, or many-to-many. For example, 
sometimes several characters may be represented by 
one glyph, as in the case of the “ffi” ligature, which cor-
responds to a sequence of three characters: f, f and i. 
Alternately, one character may be represented by several 
glyphs. For example, “é” is often considered a single 
character, but might be assembled on the fly from sepa-
rate glyphs for the base character and the accent.

OpenType layout features can be used to position or 
substitute glyphs. For any character, there is a default 
glyph and positioning behavior. Applying layout fea-
tures to one or more characters may change that default 
positioning or substitute a different glyph. For example, 
the application of the “small capitals” feature to the “a” 
would substitute the small cap “a” glyph for the usual 
lowercase “a” glyph.

OpenType layout features

To access alternate glyphs or apply alternate positioning 
with an OpenType font, an application must understand 
OpenType layout features and present a user interface 
that allows end users to select and apply different layout 
features to text.

OpenType and Adobe Applications
Current versions of InDesign, Illustrator and Photoshop 
all provide OpenType layout feature support. With these 
OpenType savvy applications, you can turn on Open-
Type layout features that automatically substitute alter-
nate glyphs in an OpenType font, such as automatic 
ligatures, small capitals and proportional oldstyle figures.

This support simplifies the use of professional typo-
graphic features once considered cumbersome, and pro-
viding exciting new typographic capabilities.

Those layout features that have some effect even on non 
OpenType fonts (such as all caps, small caps, and liga-
tures) are on the main flyout from the InDesign charac-
ter palette. However most OpenType layout features are 
accessed either by the OpenType sub-menu of the char-
acter palette flyout (for InDesign) or from the Open-
Type Palette (for Illustrator CS). The many OpenType 
formatting options are discussed in detail below.

To gain a better understanding of the features supported 
in each OpenType font, in InDesign or Illustrator CS 
you can use the Glyph Palette to view the glyphs avail-
able for each feature (see section below). Remember that 
not all fonts have all OpenType layout features, and that 
some features work only on certain characters.

There are three features which have an effect on non-
OpenType fonts, but do more with OpenType fonts 
that have relevant layout features. These features—liga-
tures (which are on by default), all capitals, and small 
capitals—are directly accessible from the main flyout 
of the InDesign character palette. (Photoshop 6 and 
InDesign .x have no OpenType sub-menu, and also put 
proportional oldstyle figures on the main menu.)

In InDesign 2.0, these typographic features are included 
on the main pop-up menu because they can sometimes 
be used with non-OpenType fonts. See the individual 
feature descriptions for details.

Note: In Adobe applications, selecting the Super-
script and Subscript options on the Character palette’s 
main flyout will create these glyphs by scaling full-size 
numbers, even if the selected font contains designed 
superscript/subscript glyphs. To access designed glyphs 
contained in an OpenType font, you should instead use 
the “Superscript/Superior” and “Subscript/Inferior” fea-

a➔a a➔A a➔a
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tures on the OpenType flyout menu or palette. See the 
OpenType layout features glossary below for details.

To apply OpenType layout features in  
InDesign or Photoshop

1  Insert your cursor in a text box to apply the feature 
to new text, or select existing text you wish to format.

2  Select an OpenType font from the Character palette 
or via the Type > Font menu.

3  In the Character palette, click on the triangle in the 
top right corner of the palette to open the flyout 
menu that lists possible formatting options. 

4  Either select a formatting item on the main flyout 
that may activate OpenType features, or (in InDesign 
only) select the OpenType sub-menu, and a format-
ting option on that sub-menu. 

  A check mark will appear next to a feature that is 
turned on. If the OpenType font has the desired fea-
ture and glyphs, it will be applied. Remember that 
not all fonts have all OpenType layout features, and 
that some features work only on certain characters.

     For example, text with the “Discretionary Ligatures” 
feature turned on might automatically replace cer-
tain character combinations such as “ct” or “st” with 
a ligature such as “ct” or “st.”

 If an OpenType layout feature appears in brackets 
[like this], then the currently selected font does not 
support that particular feature. 

 A dash next to an advanced OpenType layout feature 
means that you have selected a block of text that has 
an OpenType layout feature applied to some of the 
text. A check mark will appear next to a feature that 
is turned on for all the selected text. 

To apply OpenType layout features in Illustrator CS

1  Insert your cursor in a text box to apply the feature 
to new text, or select existing text you wish to format.

2  Select an OpenType font from the Character palette 
or via the Type > Font menu.

3a In the Character palette, click on the triangle in the 
top right corner of the palette to open the flyout 

menu that lists possible formatting options. Select a 
formatting item on the main flyout that may activate 
OpenType features, such as All Caps or Small Caps.

 A check mark will appear next to a feature that is 
turned on. If the OpenType font has the desired fea-
ture and glyphs, it will be applied.

   OR

3b Use the OpenType Palette (which can be found 
grouped with the character and paragraph palettes) 
to select desired features.

     

Features may be turned on with the selection boxes 
(for figure type and position) and the icons (for all 
other features). The selection boxes show the current 
state of the figure type and position. Features that 
have icons and are turned on are highlighted in the 
palette. Icons cannot be selected when they are not 
supported in the currently selected font; the cursor 
will turn into a “no entry” symbol when placed over 
such an icon.

        Fractions
       Ordinals
      Titling Alternates
     Stylistic Alternate (#1)
    Swash
   Discretionary Ligatures
  Contextual Alternates
 Standard ligatures

Figure Type:
 Default 
 Tabular Lining
 Proportional Lining
 Proportional Oldstyle
 Tabular Oldstyle

Figure Position
 Default
 Superscript/Superior
 Subscript/Inferior
 Numerator
 Denominator
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OpenType layout features glossary
Below are descriptions of the OpenType layout features 
supported by Adobe applications, and guidance on how 
and when to use these features.

To see at a glance which features are supported by 
which Adobe applications, see the reference chart in the 
appendix at the end of this user guide.

Some effects similar, but inferior, to OpenType layout 
features can be created synthetically by scaling regu-
lar-size glyphs. Because these effects do not use real, 
designed glyphs, these are referred to as “faux” effects 
(faux is a French word meaning “false”). Layout features 
which may have faux equivalents include small caps, 
fractions, ordinals, superscript/superior, subscript/infe-
rior, numerators and denominators. For the best results, 
whenever possible you should access real designed 
glyphs via OpenType layout features.

All Caps: With both OpenType and other fonts, this for-
mats the text in uppercase. With OpenType fonts, it also 
applies OpenType layout features for alternate upper-
case positioning of punctuation, and spacing designed 
for all-cap use.

typed uppercase ¿QUE? ‹ROMA-PARIS› (I)
formatted all caps ¿QUE? ‹ROMA-PARIS› (I)

Small Caps: With both OpenType and other fonts, this 
formats lowercase text as small caps. (Note: compare 
with  “All Small Caps” feature below.) If the font has 
OpenType small caps, these will be used. If the font has 
a companion Expert Set font, InDesign may be able to 
tell that the font is associated with the base font, and 
use the small caps from the Expert font. For other fonts, 
either small caps will not work, or the application will 
synthesize small caps from capital letters. Observe how 
these “faux” small caps look light and spindly next to 
the capitals, while the designed small caps match the 
appearance of their full-size siblings.

faux small caps LIFE IS BUT A POOR PLAYER

real small caps Life Is But A Poor Pla
Ligatures: This activates any standard ligatures in an 
OpenType font (ligatures that the type designer sug-
gests should be customarily used). In an OpenType 
font, these can be any ligatures the type designer chose 
to create. The major reason for standard ligatures is to 
avoid awkward collisions between letters, creating more 
elegant text (see example below). Standard ligatures are 
on by default in Adobe applications that support them.

In non-OpenType fonts, InDesign (only) will still acti-
vate any of the basic f-ligatures that are in the font. In 

many fonts, this is only the fi and fl ligatures, though 
InDesign may also recognize the ff, ffi and ffl ligatures if 
they are present.

Many Adobe Pro fonts include a large set of standard 
ligatures, such as fi, fl, ffi, ffl, ff, fj, ffj, Th, and others. 
Most other OpenType fonts from Adobe have at least fi 
and fl, and some have fi, fl, ff, ffi and ffl.

without ligatures This office fjord halfb
with ligatures This office fjord halfb

Discretionary Ligatures: In supporting Adobe applica-
tions, this activates discretionary and historical liga-
tures, both of which should be used sparingly for special 
effects. These ligatures may include ct, sp, st, and sev-
eral historical “long s” ligatures such as ſh. Only select 
OpenType fonts have discretionary and historical liga-
tures.

without disc. lig. Most eſſential effects
with disc. lig. Most eſſential effects

Fractions: Turns on fractions. Some OpenType fonts 
from Adobe only have three basic pre-built fractions 
(½, ¼, ¾), while others have a larger set, often including 
⅛, ⅜, ⅝, ⅞, ⅓ and ⅔. The extent of pre-built fractions 
may vary between fonts. Select OpenType fonts can also 
support any arbitrary fraction such as 11⁄12 or 7,402⁄12,597. 
In all these cases, these designed fractions match the 
weight of the rest of the font better than fractions which 
are fauxed by scaling regular-size numbers.

Note: You should only apply the fraction feature to the 
specific text you want to turn into a fraction. Apply-
ing the fraction feature to other numbers may result in 
unexpected effects—either initially, or later if the text is 
switched to a different font with a different implementa-
tion of fractions. 

faux fractions 11⁄8  31⁄2 22⁄7   511⁄12  81,234⁄4,567

real fractions 1⅛ 3½ 22⁄7 511⁄12 81,234 ⁄4,567
Ordinals: Switches regular glyphs to designed super-
scripted glyphs, such as the “st”’ in 1st, “nd” in 2ⁿd, and 
so on. Virtually all Adobe fonts have the masculine 
and feminine ordinals required for Spanish segunda/
segundo (2ª, 2º), but not all have the full set of super-
scripted glyphs needed for English ordinals. In Open-
Type fonts from Adobe,  the № (number) character and 
the “h” required for ordinals such as “4th” are generally 
present only in Pro fonts. Some Adobe Pro fonts also 
have the superior “g” and “é.”

Some applications, such as word processors, can auto-
matically synthesize ordinals by scaling regular let-
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tain acronyms and abbreviations such as USA, UNICEF, 
FBI, GDP or MADD. (See also “Small Caps,” previous.)

Stylistic Alternates: Substitutes the first stylistic alter-
nate (if there is one) for the selected glyph(s). Stylistic 
alternates is a feature for stylistic variations that are not 
covered by other features, and do not affect the entire 
font. Although it is possible to have more than one sty-
listic alternate for a given character in a font, Adobe’s 
current approach accesses only the first one. The exam-
ple below shows stylistic alternates from several differ-
ent fonts.

without  &    a E G M R   β θ φ π κ
with stylistic alts  &   a E G M R   ϐ ϑ ϕ ϖ ϰ

Superscript/Superior: Substitutes designed super-
scripted glyphs. These designed glyphs match the weight 
of the regular letters and numbers better than synthe-
sized (faux) superscript glyphs. Note that the select 
OpenType fonts from Adobe which support this feature 
do not have all characters available in superscript form. 
Instead, they generally have the letters “abdeilmⁿorst,” plus 
a full set of numbers and basic punctuation. Pro fonts 
generally add the “h” as well. This subset of the alpha-
bet represents all the characters needed for ordinals and 
common superscripting needs in western languages.

faux superscript x14y37   πr2   4a

real superscript x¹⁴y³⁷   πr²  4a

Subscript/Inferior: Much like superscript (above), but 
for subscripted characters. However, the select Adobe 
fonts which support subscripts generally have only 
numbers and punctuation, with no letters.

faux subscript H2O  CH4  n37

real subscript H₂O  CH₄  n₃₇

Numerator: Substitutes designed numerator glyphs (the 
top part of a fraction) for numbers. Those OpenType 
fonts from Adobe that support this feature generally 
have a full set of digits and basic punctuation in numer-
ator form. However, it is generally more convenient to 
simply apply the fraction feature.

Denominator: Just like numerators, but for denomina-
tors (the bottom part of a fraction).

Figure (number) Types: Tabular figures are all of equal 
width. They are only needed when the figures must all 
line up from one line to the next, as in a table. Propor-
tional figures have varying widths, just like most let-
ters; each number has a width appropriate to its design. 

ters. As always, real designed ordinal glyphs are a better 
match for the full-size numbers than the faux ordinals 
created by simple scaling.

faux ordinals 1st 2nd 3rd 4th 2a 2o

real ordinals 1st 2ⁿd 3rd 4th 2ª 2º
Note: Like fractions, the ordinal feature should not be 
applied globally, but only where needed. Some fonts may 
use contextual rules to implement ordinals, while others 
will turn them on for all selected text. Also, ordinals 
work best with lining figures, rather than oldstyle figures, 
because of the constant vertical position of the ordinals. 

Swash: Substitutes swash glyphs (stylized letterforms 
with extended strokes; see below). Even if this feature is 
globally turned on, it may only apply swashes in certain 
cases, such as when a character is at the end of a word. 
Swashes should be used sparingly for special effect. 
Only select OpenType families contain swash glyphs, 
and in families which do contain swash glyphs, they are 
often present only in the italic faces within the family.

without swash  Aidan Sue Veronica
with swash  Aidan Sue Veronica

Titling Alternates: Substitutes specially-designed 
glyphs to be used for large-size settings such as titles, 
usually all in capitals. Only select OpenType fonts from 
Adobe have titling alternates.

without titling FINESSE   BEAUTY
with titling FINESSE   BEAUTY

Contextual Alternates: In supporting Adobe applica-
tions, this substitutes both alternate glyphs and ligatures 
that only occur depending on what letters are nearby. 
This feature is on by default in InDesign and Illustrator. 
Contextual forms can have striking effect in those select 
OpenType fonts that make use of them. For example, 
Caflisch Script Pro (below) uses contextual forms to 
create variety and a realistic calligraphic handwriting 
appearance.

without contextual new azaleas bloom where
with contextual new azaleas bloom ere

All Small Caps: Unlike the traditional small caps fea-
ture, which turns only lowercase into small caps, this 
substitutes small capitals for all characters typed or 
selected—both uppercase and lowercase letters.

“All small caps” should be used instead of “small caps” 
whenever the underlying text is uppercase, as with cer-
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Unless there is a special need for tabular figures, you 
should use proportional figures.

Lining figures are all the same height, usually similar to 
that of capital letters. They are needed only for use with 
all-capital settings, or when a particularly modern look 
is desired. Oldstyle figures are of varying height. They 
are appropriate for use with lowercase or mixed-case 
text, and especially if a classic or refined look is desired.

lining oldstyle

tabular 0123456789 0123456789
proportional 0123456789 023456789

Default figures are whichever type are encoded as the 
standard figures in the font. For historical reasons, these 
will usually be tabular lining figures, though the deci-
sion is up to each font manufacturer. Because tabular 
lining figures are rarely the best choice for a document, 
we recommend actively choosing figure types for each 
particular usage.

The Glyph Palette

While OpenType layout features are primarily accessed 
via the OpenType menu, Adobe InDesign (all versions) 
and Adobe Illustrator CS also allow you to view and 
access all of the possible glyphs and layout features in 
an OpenType font through a single window, the Glyph 
Palette. 

1  Insert your cursor in a text box.

2  Select Type > Insert Glyphs…  The Glyph Palette will 
appear.

3  Select a font in the font selection field. Select the 
appropriate font weight or style in the style selec-
tion field. All of the possible glyphs in the font will 
appear.

 You can also click on the size icons to increase or 
decrease the point size of the glyph samples in the 
window.

 If there are alternate forms of a glyph available via an 
OpenType layout feature, a small triangle will appear 
in the lower right corner of the glyph cell. Clicking 
and holding on such a glyph cell will activate a flyout 
showing all the alternate glyphs. 

4  Double click on a glyph cell, or if there is a flyout, 
click-hold and select the desired alternate glyph. The 
glyph will then be inserted in your document wher-
ever your text cursor was positioned.

You can filter the glyphs displayed in the dialog by using 
the OpenType layout features pop-up menu. This pop-
up menu will display all of the substitution features sup-
ported by the currently selected OpenType font. After 
choosing an OpenType font in the font selection field, 
select a layout feature, such as discretionary ligatures 
or swash, from the pop-up menu and the dialog will 
display only those glyphs that are available through that 
layout feature.

You can view only the alternate glyphs available for a 
single selected glyph in your InDesign document by 
selecting “Alternates for Selection” from the “Show” pop-
up menu of the Glyph Palette. (If more than one glyph 
is selected, the Glyph Palette will show no alternates.)

Adobe applications remember the last OpenType layout 
feature you used the next time you activate the Glyph 
Palette. To return to a view of all the glyphs in the font, 
select Entire Font from the pop-up menu.

For more information about the Glyph Palette, please 
refer to the Illustrator or InDesign User Guide, as 
appropriate.

Font selection field
Glyph selection flyout

Show OpenType layout features

Style selection field

Change display size

Alternate glyph 
indicator
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User Interface
OpenType layout 
feature codes
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oldstyle  
(proportional oldstyle)

pnum + onum • • • • • •

ligatures liga • • • • • •

discretionary  
ligatures

dlig + hlig • • • •

all caps case, cpsp • • • • • •

small caps smcp • • • • • •

all small caps smcp + c2sc •

all alternates  
(via glyph palette)

aalt • • •

glyph palette
most other features 
(by applying filters)

• • •

tabular lining tnum + lnum • •

proportional lining pnum + lnum • •

tabular oldstyle tnum + onum • •

fractions frac • • •

ordinals ordn • • •

titling alternates titl • •

swash swsh + cswh • • •

contextual alternates calt + clig • • •

superscript/superior sups • •

subscript/inferior sinf • •

numerator numr • •

denominator dnom • •

ornaments ornm •

stylistic alternates salt (first alt only) • •
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